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) Teamcenter CAD data management

Enterprise Rich Client CAD Connectors

* Provide a single source of all product Program
knowledge for the extended enterprise P‘f\\\
* Link global teams including partners S
and suppliers
* Implement industry specific business dae 2
process and control rules ﬁ;}
* Provide secure global access to all e
product information “anytime,
anywhere”
v Enterprise scalability v" Option & Variant Management
v" Re-use of knowledge v" Process Management / Workflow
v" Document Management v Part Classification
v Configuration Management v" Supplier Management
v" Change Management v" Reporting & business metrics



.“‘v Teamcenter CAD data management

Enterprise Rich Client CAD Connectors

» Where Enterprise Knowledge Management is the focus enabling
collaboration throughout the extended enterprise

» Enabling users to author MCAD data in support of enterprise-wide
pI’OCeSSGS [ uGs Teamcenter Enerprise 2005 g@

File Edit \ie
: Z¢ller n=E| seses
@uu%MmEtiesecoxy zH|

My -Wﬁ}kgsi
a0
L))

My Teams

iy Local Data




%

) Teamcenter CAD data management

Enterprise Rich Client CAD Connectors

» PDM Centric

» Simplicity of operation

» Reduced requirement for training
» Focus on core data management commands
» Open, Save, Check-out / Check-in
» Synchronize / Cancel / Release
» Attribute Mapping
» Create/Edit product structure ‘
» Resolve Key Collisions _— &\ (S >
» Get Latest version from PDM
» Support CAD Obijects
» Parts, Assemblies, Drawings

» Embedded Visualization
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D Teamcenter CAD data management

I'M |||

Enterprise Rich Client CAD Connectors

Drag & Drop CAD Models to PDM
» CAD files cached locally
» Users may work off-line

» Data may be synchronized with PDM
» Support Multi-CAD product structure
» CAD Tool Specific Features
» Inter-part relations (NX, I-deas, CATIA V5)[ ]
» Wave, CWA, MML
» Design in Context

# Unigraphics NX 2 - Gateway - [assy.

» Use JT for non-native CAD
» NX
» |-deas
» CATIA V5
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) Teamcenter CAD data management

I'M |||

Engineering CAD Integrations

* Reduce new product development and
introduction (NPD/I) timescales

* Enable rapid iteration to evaluate
multiple design concepts early in
process

* Automatically validate multiple design
variants

.
-
|

* Synchronize distributed multi-site, multi-
disciplinary design teams

* Enable multi-CAD collaboration

v" Knowledge Capture as created

v Engineering Process
Management

v" Repeatable Digital Validation
Multi-CAD Collaboration
v Product Structure Management

Option & Variant Management
Configuration Management
Change Management

Part Classification

Reporting

NN N N X
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v Teamcenter CAD data management

.
‘ - Engineering CAD Integrations

» Where Engineering Process Management is the focus enabling
Work-in-Process and Pre-Released Configuration control

» Supporting deep, rich MCAD integration to get the most out of the

:ﬁu nigraphics ¥18.0.1 - Gateway - [Displayed: assy_demo.prt Work: (Modified)

L ]
7y Fle Edit Wiew Ingert Fopmat I,wls e’_l.wble-" WCS  Informati

CAD system
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) Teamcenter CAD data management

o

Engineering CAD Integrations

» Work in progress CAD support

» CAD Centric plus PDM interaction
» Familiar CAD User Interface

2% Bracket.iam

» Extended CAD management
» Open, Save, Check-out / Check-in

» Synchronize / Cancel / Release
» Attribute Mapping

» Create/Edit product structure

» Get Latest version from PDM

» User Settings

» Import / Export

» Granular CAD relation support
» Support CAD Obijects

» Parts, Assemblies, Drawings

» Application specific

A_O02270_A CATPart

B 10
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9~ Teamcenter Express

Wed

Teamcenter Express for NX and |-deas NX Series Users

3:30
Barry Dudley

OOTB pre-configured Teamcenter processes
Simplified Installation, Set-up and Deployment
Built-in growth path to Teamcenter Engineering

11
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» Teamcenter CAD data management
» CAD Connectors

» CAD Integrations

[ » Integration for |-deas }

» What’s New & Roadmap
» Integration for NX
» What's New & Roadmap

» Summary

12



Integration for I-deas

Paths to NX

» Many Paths are Available from |-deas to NX

» One Path
» Is Validated All the Way to NX
» CMM Results are Traceable to Original TDM Datasets

» Customer is Ready & Prepared to Transition to NX

» Is Supported & Strongly Recommended by UGS
» Any Other Path
» Will Not be Supported by Tool Automation &

Functionality
» Must be Carefully Considered and Reviewed

» With the Services Transition Team

13
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Integration for I-deas

The “One Path” to NX: Definition

“One Path” is a Set of Options that Must be Used in
the Migration from I-deas to NX through Teamcenter

Engineering
» One Version Per Revision
» During Metadata Migration
» During Save to Teamcenter Engineering

» Part, Assembly, Drawing & FEM Datasets

» Each Dataset Type in It's Own ltem Revision

» No Two Dataset Types in the Same Iltem Revision

» One Acceptable Exception is to Have Drawings of a
Single Part or Assembly with the Same Item ID (Part

Number) in the Same Item Revision

» Integration for I-deas Installation Defaults

14



Integration for I-deas

Teamcenter Engineering Benefits

>

Scalability » “One Path” Defined for I-deas to NX

» Number of Users » Team Data Sharing / Access

» Amount of Data » Multiple Sites

» Multiple Geographic Locations

» Search » Multiple CAD Applications

» Faster Than TDM
» JT
» Visualization

» Check-out to |I-deas for I-deas
or Non |-deas Data

» Interoperability For CAM & CAE
» CAD, CAM, and CAE Support

» Performance is Better than TDM for
More that Three Users

» Manage Non-CAD Data

15



v _ Integration for I-deas
© functionality highlights

I'M |||

» Check-in/Check-out
» Where Used, Where Referenced

» Prune/Unprune

» Visualization support

» PSE support for Top-down design

» TDM migration tools

» Supports non- |-deas data

» Interoperability with NX and JT files
» associative with NX

» Scalability

16
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9~ Integration for I-deas

2005

Apr

Jul

TcEng 9.1.2 ReleaSed
I-deas 10, 11, 12

Enhanced Freeze-
Revise support

Drawing Sets

Detect RefMod
condition

TcEng 9.1.2, 9.1.3
|-d§§l?ﬁsed

WinXP, HP, Sun

v Enhanced Save
Form Ul

17
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9~ Integration for I-deas

2005 SR1

TcEng 9.1.3 Released I-deas 12m1 PTF2

I-deas 11, 12 Support 4-tier architecture

Hubless data sharing/migration FMS support
Enhanced Check-in/out FEM: Update NX Assembly in

Performance Model File

Enhanced I-deas data audit tools

TcEng 9.1.3

TcExpress 1.3

I-deas 11, 12

Unprune from Assembly Hierarchy
v Requires I-deas 12m1 PTF2

MFV enhancements

ACF Check-in enhancements



) Integration for I-deas

‘V
- What’s New in V4.0

Detect RefMod condition o X

» Detect during the Send to il
|-deas command if the data
being sent to I-deas is
reasonably expected to result in
a Referenced but Modified
condition later during Save to
Teamcenter Engineering

2 [ Check ot [ Prure | Faceted

Check ot [ Prune [ Faceted

» Notice that user selected

‘ C h e C ko ut M Od ifi e d ¥ Checkout Modified Assemblies
Assemblies” iy [

» Items that may cause ref-mod il
condition will have a new e

“caution” icon b '

> I t e m S th at n e e d t O b e C h e C ke d u o : i = tuzt be checkad out for modification.
OUt WI II have the CheCk OUt e . Referenced but Modified condition.
boxes checked el




v _ Integration for I-deas
¥ What's New in V4.0

Detect RefMod condition "4 Send to I DEAS

Setkings

» This is the Send to |-deas form L
which is available in the My
Navigator module of Teamcenter
Engineering (it is not available in
the Product Structure Editor)

I'M |||

A new option was added on the

form, “Checkout Modified
Assem bl iesn @mm Modified @

Destination Bin

Fevizion Rule: |

When the user selects this option, Man ]
all items that can cause Ref-Mod o
condition later on during check in L ==
will automatically be checked-out Comments:

Change Revizion RBule |




v _ Integration for I-deas
¥ What's New in V4.0 “Teancenrer

Detect RefMod condition 1

» This example shows the new icons in use sk
on the Send to I-deas form if the user 5 G TETT———  ccou
selects ‘Checkout Modified Assemblies’

(4 Rhrnprt! B-rbmprt! | Check Ot | Prune | Faceted
Iter.ns th.a.t cau$e a R“e.f'M,,o.d condition will % Romprt2B-rbmprt2 [ Check Out [ Prune [ Faceted
be identified with an “info” icon. In the

example, items on the second and third
line have the “info” icon

2 Send to I-DEAS

@ hhgid-hhg | Check Out | Prune | Faceted

The affected assemblies will be identified
with an “exclamation mark” icon. These
are the items that will have to be
checked-out. In the example the top level 7
asl\lseqnbl)r/] is affﬁcte(c:jH Thke Sffecged items Destination Bin

will also have the “Check Out” boxes Revision Fule;
automatically selected ven 7|

Notice that the top item is automatically
expanded (Expand All is executed)

Change Revizion Rule

Check-out History

Change (O

Comrmerts:

Ok | Cancel |




v _ Integration for I-deas
¥ What's New in V4.0

Detect RefMod condition

» If one or more of the assemblies = Sent to ) dear [X]
affeCted by a Ref MOd Condltlon There were swarnings generated during this operation
cannot be automatically checked- Do you wish to procesd?
OUt’ the user WI” be Informed What ITdeashdssembly Fbmassylsd is already checked out to you;
T[hese .Items are an_d the reasons, if it is not already checked out in the current model file
|nC|Ud|ng the user |d Of the peI’SOH it will be sent refererence-latest.

who has items checked-out.

» This information will also be output
to a log file (that can be printed or
saved). Select the “Save As” button.

» At this point the user will have an
option to either cancel or continue
(check-out as many items as
possible)

22
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Integration for I-deas

Enhanced Save Form Ul

>

Enhanced Save
Usability

Assign Project during
Save

Enter mapped

What’s New in V4.1

il
m
o
)
I
i
IIIII*"
I
i

b Save As...

I Paet Hurriber ] Ecnid Rervizion

&

Haaren | Rem Type | Dataset Type i Progects " _Checkin intent
cpere fem Part Sawe & Checkin
bk tem Part Sawe & Oheckin
BLm Eem Azzombly | Save & Checkin
aum tem [T Save & Checkin

Scroll bars

Rem Type: !EEm

Attributes during Save P LN

Ability to define
“required” fields for
site

Minimizes user entry
compared to previous
NXMI releases

Projects Afiriates

(* Save & Checkin

™ Save Checkin, & Remove

!- o Project Selection ... s |

-zelect Projects to Azsign Ohject to

Frojects for Selection Zelected Projects

testProject
TestProject2

& Error

e Errorlincarnplete Data, The Faollowving Infarmation is recguired

03193 Requries Praject
lock: Requries temld, Project
03194: Requries Revisionld, Project

| Cancel
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+ Integration for I-deas
¥ What's New in V4.1

Enhanced Save Form Ul

» Provides more options and control for
saving items

» Provides columns for saving:

» Part Number
» |ltemID
» Revision ID
» Name _,
= Project Select
» ltem Type
» Dataset Type

» Projects

Checkin Intent

24



+ Integration for I-deas
¥ What's New in V4.2

LY

Enhanced Audit Tools
» Diagnostics and Wizards
» Emphasis on improving the total migration process

» Post migration validation and trouble shooting
» Further improvements planned to provide smart analysis of log

files and automation for resolving issues

leanup Wizard
Cleanup I-deas Registry

Exract/ List File
|||||

besgrCenten

EEEEEE
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Integration for I-deas

What’s New in V4.2

Enhanced Performance

>

Performance benchmarks represent
the productivity improvement of
using Teamcenter

Focus benchmarks on concurrent
access to Teamcenter

» More realistic test and shows
significant Teamcenter benefit over

TDM

Integration for I-deas 4.2 includes further
performance improvements for Check-
out and Check-in

Pre-requisite to any performance testing
is to configure Teamcenter according to
performance guidelines

Reference

@ TDM
B TcEng I-deas
O TcEng NX

assembly




v _ Integration for I-deas

A What’s New in V4.2

Multi-Site Enhancements
» Improved Multi-Site usage with |-deas

» ODS extension to store I-deas GUID’s as part of the Publication Record class
» During |-deas data migration, this attribute will be populated and queried

» Eliminates current requirement to define a Hub site for querying during data
migration to prevent creation of items with duplicate GUID’s

» Does not require explicit Publishing and not effected by un-publishing
» Simplified deletion

» Reduces the administrative overhead (resource/machine/maintenance)

> Independent Of ItemID Changes Inf (‘ n\l Meduugltaren vh E ? Intgr-Qnmnany
lients % s
[l . o Eﬁ! LOV/ IViediiT
» Improves performance of Import L Lowéf,mcy%% : ﬁ@;@ Latency lionts
. . AL Tt e s ilents ol ) AREEE e s
and Migraton ¥ Eﬂ;‘;‘;”“’*;“ﬁgb W
. 3 '.‘ EnrﬂgﬂDMZ :
» Ownership Transfer L““’éﬁéi’:?’s%% w\_ ol @M"‘”“Z’éi’é””
~ ““'“HighLarency ‘! Almast any.

Low i’.aten cy

Latency. -
- . !
e :Fi&ve Network ﬁi - -Ct‘iems

» Full transfer

» Remote Checkout i ol
» Migration and TDM PKG Import into Satelite Site Ce| |
Multi-Site installations e Sevicr | | [ suppiersie o




) Integration for I-deas

‘.|||I||||“|’|

I'M |||

‘V
- What’s New in V4.3

» Unprune from Assembly Hierarchy

» Today the user can only unprune
from the I-deas Model File View
window

a1,
lﬁi Mewy D taset Mame 1, New Dravving Rem D01, rev &, vl

» This enhancement will allow the
user to unprune from the |-deas
Assembly Hierarchy Form

» Model File View enhancements

» A new icon row under the menu bar
of “I-deas Model File View” window

» Removes user interaction steps
» ACF Check-in enhancements

» Allows a user to work on the target
part without requiring that user to
have the source and context also
checked out

28



Integration for I-deas 2005 SR1

€ What's New

» Multi-tier Support

» Enables Integration for I-deas to be deployed in the Teamcenter
Engineering multi-tier environment

» Easier Multi-Site deployments

» Update NX assembly in |-deas

e Manag
eeeeeee

WEB TIER

FLM SOAP Services

ENTERPRISE TIER

Database File Vaults

29



) Integration for I-deas 2005 SR1

v
v What’s New

» Detects an out-of-date
version/revision of NX assemblies
in an |-deas Model File

Fil= | Edit WYiew Manage Bins Help

» Allows user to update an out-of- T
date NX assembly within the |-deas Flo Edt vin
Model File :

» |-deas Assembly FEM'’s created on
NX assemblies retain associativity



I'M |||

» Teamcenter CAD data management
» CAD Connectors
» CAD Integrations

» Integration for |-deas

» What’s New & Roadmap

[ » Integration for NX }

» What's New & Roadmap

» Summary

31



v _ Integration for NX

I'M |||

© functionality highlights

» Check-in/Check-out
» Explicit & Implicit
» UDF Management
» Part number assignment

» Where Used, Where Referenced

» Visualization support

» PSE support for Top-down design
» Import/Export

» Interoperability with |-deas, Solid Edge and JT files
» Scalability

Ky
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W~ What Customers are telling us...

I'M |||

 Teamcenter browsing, searching and other Teamcenter
Interactions needs to be available in-NX

* Reduce the need to train NX designers on Teamcenter

» Reliable & foolproof structure synchronization

» Increase types of data that may be opened into an NX Session
» Define mandatory data entry when creating parts

» Import/Export needs to be less complicated

» Allow “acceptance” activities in NX before saving to Teamcenter

33



|

;‘v The In-NX Experience

Vision / Strategy

Scope of the “In-NX" experience for managed environment...

Designer - Engineer

“Touch Points” into “Touch Points” into

Teamcenter for Cioatine Participation in CAD for managed
managed CAD modifying CAD- businﬁsdpi'oiﬁsses Teamcenter
. reidatea to tne
design: related datasets b e processes:
. (model, drawing, control, review and
»Navigate / Browse analyses etc) in a release of CAD- > New ltem

related datasets
(designs) »New Item Revision

»Digital Mock-Up

» Attribute Search m.anaged
environment

»Spatial Search
» Classification Search » Standards Control
» Create New

»Open/Load Parts

»Review & Markup

»Change Order
»Work Order

» Project Control

»Open/Load Configurations
»Save / Vault

» Expose
P » Iltem Release

»Import/Export, Clone
»Where-Used

» Where-Referenced

Teamcenter

34




.“‘v The In-NX Experience

Vision/Strategy

Scope of the “In-NX" experience for managed environment...

4 Designer / Engineer

Participation in

. business processes
modifying CAD- related to the

related datasets creation, update,
(model, drampg, control, review and

In-NX

Creating and

Navigate, Attri
Search, Classif
New, Open/Loa
Expose, Import
K Unmanaged Da

, Spatial New
rch, Create Digit

m Revision,
Standards
Markup,
ork Order,
em Release

ntrol

ion Manage

Business processes related to the
creation, modification, control, review,

roll-up, release and obsolesence of
products and their configurations (PLM)

35
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2005

Teamcenter 2005
Integration for NX

Apr

Jul

2005 (V10)

Al

Oct

\

2005 SR1 (V10.0.1)
I I Al

2006 Apr Jul

NX 4 Support

FMS support

Support visualization of assemblies
with Variable Component Positioning
and Arrangements

Incremental Change

Improved variants functionality
Full support for modular variants

I-deas style wire harness variant
assemblies

Transient & Incomplete Assemblies
NX Derived data

36



Teamcenter Engineering 2005 SR1

I'M |||

‘V
- What’s New in NX 4.0.2

» Full FMS Support
» VCP & Arrangements

» Transient & Incomplete Assemblies
» NX Derived data

» |-deas style Wire Harness variant assemblies
» NX Routing

- All functionality listed requires Teamcenter
< Re mOte C h eCkI n/C h eCkO Ut Engineering 2005 SR1 and NX 4.0.2.

(This functionality is not supported with Teamcenter

> Pa rt Fa m | Iy | m p roveme ntS Engineering 9.1.3 or earlier releases.)

(This functionality is not supported with NX 4, NX
4.0.1 or earlier releases.)

37



‘v Integration for NX

What’s New in 4.0.2

FMS Support

» Completes NX support of new
FMS capabilities delivered with —
NX 401 tl;-\;::ZdCICI?An[t) SOA based

CAD
» Enables partial download of
files across the WAN/LAN for all
security levels ... only those
areas in the file needed by NX
are downloaded into the local
cache

» Provides security improvements
by preventing direct access to
files within Teamcenter volumes

38
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) Integration for NX

What’s New in 4.0.2

Arrangements support

> Provides_ more acc_urate visualization c_)f NX_
assemblies saved in Teamcenter Engineering

» Save multiple NX Arrangements (not
just the default)

» Save Variable Component Positioning
(VCP) information

» Select any one of the
arrangements to view in
Teamcenter Engineering’s PSE

» Provides the ability to modify positioning data
in any arrangement and have those
modifications sent back to NX through
Teamcenter Engineering




‘v Integration for NX

What’s New in 4.0.2

Transient & Incomplete assemblies

» Enables NX to work with assembly
information from Teamcenter that is
“‘empty” or contains a “foreign”
geometry definition

» Enhances integrated multi-CAD T
capability; allows users to work with ] |
“virtual” assemblies, or those not
authored in NX

» Supports workflows appropriate to
multi-CAD

PreNGIHELE

Pf} TEA

AutoCAD  SolidWorks

40



Integration for NX
What’s New in 4.0.2

._v

NX Derived data

» Enables NX part files to reference
geometry in JT files (NX requires
an NX part file be created and
persisted)

» Provides a new method to attach
persisted dataset(s) to the dataset it
Is derived from with a non-
specification relationship (removes
hard-coded relationship)

» Supports Access control and
Workflows appropriate to multi-CAD

N* Engineering Multi-CAD .

Available 2005 Plans

|-deas Solid Edge Inventor
‘:"‘ s w—-.‘_:‘ NX (CAE)
- ’ 9 B A

CATIA _ ProlE
v4 NX (Routing)

5
Dr}rm

AutoCAD  SolidWorks

AatelAD
Cadence (PCB)

cadence]

Mentor (Capital Harness)

Mento (PCB)

41



\h‘v} Integration for NX

What’s New in 4.0.2

Wire Harness variant assy support

» Provides support of the I-deas style
of variant wire harness assemblies

» Utilizes Teamcenter Options and
Variants to selectively display the
NX part

» Enables NX variant wire harness
assemblies to be properly displayed
in the embedded Teamcenter
Viewer

42



‘v Integration for NX

What’s New in 4.0.2

NX Routing support

» Enables on-demand exchange of
NX routing data with Teamcenter

» Enables Harness creation based
upon knowledge driven rules and
constraints

» Reduces harness design time
through knowledge driven design

43



L+ Integration for NX
© o)

What’s New in 4.0.2

Remote CICO support

» Enables manual Remote Check-out /
Check-in on the part or assembly
‘ugmaster’ owned by a remote site

» Enables manual Remote Check-out /
Check-in on the ‘non-master’ owned
by a remote site

» Provides automatic locking policy for
Remote ltems

» Facilitates a managed and controlled
working environment with remote sites

Client Host

\_Shared File Cache Snger

Volume Server )

44
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‘v Integration for NX

I'M |||

What’s New in 4.0.2

Part Family enhancements

>

Part Families

Enables mapping part family W Exporable P Famly Temploe
attributes to Classification attributes Expresdons |
Part Family Templates can be

automatically added to an
Import/Export when a Part Family
Member is referenced

Add Calumn
Improved support for Part families Chosen Columns
in Multi-Site implementations OR_PART NAME

45



\h“i Teamcenter Integration for NX

Functionality supported with NX 4

Teamcenter Engineering 2005 SR1

Full FMS Support NX 4.0.2
VCP & Arrangements NX 4
Transient & Incomplete Assemblies NX 4.0.2
NX Derived data NX 4.0.2
|-deas style Wire Harness variant assemblies NX 4
NX Routing NX 4
Remote Checkin/Checkout NX 4.0.1
Part Family improvements NX 4.0.2

46
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» Teamcenter CAD data management
» CAD Connectors
» CAD Integrations

» Integration for |-deas
» What’s New & Roadmap

» Integration for NX

» What's New & Roadmap

[ » Summary ]
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\ Teamcenter 2005 SR1

‘V
- Supported CAD Releases

Rich Client CAD Connector CAD Integration

|-deas 11
|-deas 12

|-deas 13
NX 3
NX 4
NX 5

ANANANANANEN
NN
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1", Teamcenter Value

I'M |||

» Establishes common procedures to improve efficiency,
reduce development time and lower costs

» Enables collaboration across a range of CAD tools,
organizational disciplines and geographic locations

» Consistent tools making it easier to find existing
designs and eliminate duplication

» Preserves integrity, reduces error, improves quality
through change and configuration management

» |s a scaleable solution from Engineering Process
through Enterprise Knowledge lifecycle management

49
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